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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in "About This Machine" before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.
Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licens-
es.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.



Manuails for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

ﬂlmportant
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Media differ according to manual.
The printed and electronic versions of a manual have the same contents.

Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

Depending on which country you are in, there m ay also be html manuals. To
view these manuals, a Web browser must be installed.

About This Machine

Be sure to read the Safety Information in this manual before using the ma-
chine.

This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

General Settings Guide

Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

Security Reference

This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered
with, or prevent the machine from unauthorized use.

Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

Facsimile Reference
Explains Facsimile functions and operations.

Printer Reference
Explains Printer functions and operations.

Scanner Reference
Explains Scanner functions and operations.



< Network Guide
Explains how to configure and operate the machine in a network environ-

ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.
< Other manuals
* Manuals for This Machine
¢ Safety Information
* Quick Reference Copy Guide
® Quick Reference Fax Guide
¢ Quick Reference Printer Guide
¢ Quick Reference Scanner Guide
* PostScript 3 Supplement
¢ UNIX Supplement
* Manuals for DeskTopBinder Lite
* DeskTopBinder Lite Setup Guide
¢ DeskTopBinder Introduction Guide
e Auto Document Link Guide

& Note
O Manuals provided are specific to machine types.

O For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

O “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

/\ WARNING:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

/\ CAUTION:

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the

machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

*gklmportant

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

& Note

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

A Reference

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[]

Indicates the names of keys that appear on the machine’s display panel.

[]

Indicates the names of keys on the machine’s control panel.



Display Panel

This section describes configuration using the display panel when the printer

function is selected.

JobReset |

| Meru
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1. Operational status or messages

Displays current machine status, such as
“Ready”, “Offline”, and “Printing...”.

2. [JobReset]

Press to cancel the current print job. If
you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.

& Note

|
3 ASC009S
3. [Menu]

Press to display the menu to select the
following options:

e [Show Error Log]
Displays the error logs of print jobs
that are sent from a computer.

O When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “System Settings”, General

Settings Guide.



Reading the Display and Using Keys

This section explains how to read the display and using the selection key for the

initial display.

1. Scroll keys

Press to move the cursor in each direc-
tion, step by step.

When the [A], [ V], [»], or [ €] key ap-
pears in this manual, press the scroll key
of the same direction.

2. [OK] key
Press to set a selected item or entered nu-
meric value.

& Note

ASC004S

3. [Escape] key
Press to cancel an operation or return to
the previous display.

4. Selection keys

Correspond to the function items at the
bottom line on the display. Example: Ba-
sic screen When the instruction “press
[JobReset]” appears in this manual, press
the left selection key.

O The Printer display is set as the default screen when the machine is turned on.
You can change the settings in [System Settings]. See General Settings Guide.



Printer Features Menu

The following explains settings and meanings of functions on Printer Feature.
Printer Feature screen appears when you press the [ User Tools/Counter] key. For
details, see “Printer Features”, General Settings Guide.

% List/Test Print

Menu

Description

Multiple Lists

You can print the configuration page and er-
ror log.

Config. Page

You can print the machine's current configu-
ration values.

Error Log You can print error logs listing all errors that
occurred during printing.
Menu List You can print a Menu List showing the ma-

chine's function menus.

PCL Config./Font Page

You can print the current configuration and
installed PCL font list.

PS Config./Font Page

You can print the current configuration and
installed PostScript font list.

PDF Config./Font Page

You can print the current configuration and
installed PDF font list.

This menu can be selected only when the op-
tional PostScript 3 unit is installed.

Hex Dump

You can print in the Hex Dump mode.

< Maintenance

Menu

Description

Menu Protect

This function lets you protect menu settings
from accidental change. It makes it impossi-
ble to change menu settings with normal
procedures unless you perform the required
key operations.

In a network environment, only administra-
tors can make changes to menu settings.

List/Test Print Lock

You can lock the [List/Test Print] menu.




% System

Menu

Description

Print Error Report

You can print an error report when a printer
Or memory error occurs.

Auto Continue

You can select this to enable Auto Continue.
When it is On, printing continues after a sys-
tem error occurs.

Memory Overflow

Select this to have a memory overflow error
report printed.

Memory Usage

You can select the amount of memory used
in Font Priority or Frame Priority, according
to paper size or resolution.

Duplex

You can select to have print on both sides of
each page.

Copies

You can specify the number of print sets.
This setting is disabled if the number of pag-
es to print has been specified with the printer
driver or another command.

Blank Page Print

You can select whether or not to print blank
pages.

Edge Smoothing

Set this to enable Edge Smoothing.
e On (Default)
o Off

@ Note

O If Toner Saving is set to On, Edge
Smoothing is ignored even if it is set to
On.

Toner Saving

Set this to enable Toner Saving.
e  On (Default)
o Off

Printer Language

You can specify the printer language.

Sub Paper Size

You can enable the Auto Substitute Paper
Size (A4 LT) feature.

Page Size

You can select the default paper size.

Letterhead Setting

You can rotate original images when printing.

When printing, original images are always
rotated by 180 degrees. Therefore, output
might not be as expected when printing onto
letterhead or preprinted paper requiring ori-
entation. Using this function, you can specify
image rotation.

Bypass Tray Priority

You can specify which of the two options,
(Printer) Driver / Command or Machine Set-
tings, has priority for determining the paper
size for the bypass tray.

Edge to Edge Print

You can select whether or not to print on the
entire sheet.




Menu

Description

Default Printer Lang. You can set the default printer language if
the machine cannot find the printer language
automatically.

Tray Switching You can set to switch the paper tray.

RAM Disk You can change the settings of the RAM disk.

Host Interface
Menu Description

1/0 Buffer You can set the size of the I/O Buffer. Nor-
mally it is not necessary to change this set-
ting.

I/0 Timeout You can set how many seconds the machine
should wait before ending a print job. If data
from another port usually arrives in the mid-
dle of a print job, you should increase this
timeout period.

PCL Menu
Menu Description
Orientation You can set the page orientation.
Form Lines You can set the number of lines per page.

Font Source

You can set the storage location of the de-
fault font.

Font Number

You can set the ID of the default font you
want to use.

Point Size You can set the point size you want to use for
the selected font.

Font Pitch You can set the number of characters per
inch for the selected font.

Symbol Set You can specify the set of print characters for

the selected font. The available options are as
follows:

Courier Font

You can select a courier font type.

Ext. A4 Width

You can extend the printing area width
when printing on A4 sheet with PCL.

Append CR to LF When set to On, a carriage return will follow
each line feed: CR=CR, LF=CR-LF, FF=CR-
FF.

Resolution You can set the print resolution in dots per

inch.




% PS Menu (optional)

Menu Description
Data Format You can select a data format.
Resolution You can set the print resolution in dots per
inch.

% PDF Menu (optional)

Menu Description

Change PDF Password You can set the password for the PDF file ex-
ecuting PDF Direct Print.

PDF Group Password You can set the group password already
specified with DeskTopBinder Lite.

Resolution You can set the print resolution in dots per
inch.

& Note

O Depending on which optional units you have installed or the printer lan-
guage you have selected, some options are not displayed.

O Depending on the security settings, you might not be able to set certain op-
tions.

/O Reference
For details, see “Printer Features”, General Settings Guide.

For more information about copier features and system settings, see Copy
Reference and General Settings Guide.



Setting Paper on the Bypass Tray

This section gives instructions for setting paper on the bypass tray.

For details about paper size and paper type, see “Recommended Paper Sizes and
Types”, About This Machine.

ﬂlmportant
O The following functions are disabled when printing from the bypass tray:

¢ Duplex printing
¢ Auto Tray Select
¢ Auto Tray Switching
* Rotating Collate

O When printing using the printer function, original images are always rotated
by 180 degrees (the orientation of images to be printed is opposite to that of
the copier function). When printing onto paper with specific orientation re-
quirements, such as envelopes and letterheads, be sure to rotate the paper
feed orientation to 180 degrees.

O Be sure to set the paper size using the printer driver when printing data from
the computer. The paper size set using the printer driver has priority over the
one set using the control panel.

O Paper that is thicker than 162 g/m? (max.) cannot be printed from the bypass
tray.

ﬂ Open the bypass tray.

AAWO019S1

g Lift up the paper guide release lever.

ASC001S



B Adjust the paper guides to the paper size, and then gently insert paper face
down into the bypass tray.

AAW020S1

1. Extender

2. Paper guides

Open out the extender to support paper sizes larger than A4 [, 8!/, x11 [5.

If the paper guides are not flush against the paper, skewing and misfeeds
might occur.

Gently insert paper until it stops.

Do not stack paper over the limit mark, otherwise a skewed image or mis-
feeds might occur.

Fan the paper to get air between the sheets to avoid a multi-sheet feed.

When setting an OHP transparency, make sure that its front and back sides
are properly positioned.

ﬂ Push down the paper guide release lever.

ASC0028



10

B Set the paper size using the printer driver or the control panel.

& Note

O Paper within the following dimensions can be set in the bypass tray:
¢ Vertical: 90 - 297 mm (3.55 - 11.69 in.)
* Horizontal: 148 - 600 mm (5.83 - 23.62 in.)

O Be sure to set the paper with the side you want to print facing down in the
bypass tray.

O The number of sheets that can be loaded in the bypass tray depends on the
paper type.

O When loading OHP transparencies or thick paper in the bypass tray, make
the paper setting using the control panel or printer driver.

A Reference
For details about setting the paper size, see p.10 “Setting the Paper Size Us-
ing the Control Panel”.
For details about setting paper in the regular paper tray, see General Set-
tings Guide.
When loading custom size paper, see p.12 “Setting the Custom Size Paper
Using the Control Panel”.

Select paper type when printing onto OHP transparencies or thick paper
(over 90.2 g/m?). For details, see p.14 “Setting Thick Paper or OHP Trans-
parencies Using the Control Panel”.

Select paper type when printing onto envelopes. For details, see p.15 “Set-
ting envelope Using the Control Panel”.

When loading letterhead paper, pay attention to its orientation. See Gener-
al Settings Guide.

Setting the Paper Size Using the Control Panel

This procedure describes how to set paper size of the bypass tray using the con-
trol panel. If you select the printer driver to set paper size, this procedure is not
necessary.

0 press the [User Tools/Counter ] key.

OOE ==
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ﬂ Select [System Settings] using [ V] or [ 4 ], and then press the [ OK] key.

EUzer Tool= 1/4 & [0K]
Counter

ovstem Settings

8 Select [Tray Paper Settings] using [ Y] or [4 ], and then press the [ OK] key.

Eavaten settinzs 177 ¥[0K|
General Features

Tray Paper settings

Timer Settings

ﬂ Select [Printer Bypass Paper Size] using [ Y] or [4], and then press the [OK]
key.

B ray/Paper 270 0]
Paper Size:Tray 4

Printer Bwpass Paper Size

Paper Twvpe:Bwvpass Traw

B Select the paper size using the scroll keys, and then press the [ OK] key.

P.5ize:Bvpass b5 Ak [DK]
16K [ 16K

Custom =ize

B Press the [User Tools/Counter] key to return to the default screen.

p Reference
See the printer driver Help about the settings from the printer drivers.
Select paper type when printing onto OHP transparencies or thick paper.

For details, see p.14 “Setting Thick Paper or OHP Transparencies Using the
Control Panel”.

Select paper type when printing onto envelopes. For details, see p.15 “Set-
ting envelope Using the Control Panel”.

11
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Setting the Custom Size Paper Using the Control Panel

The following procedures are not required if you select the printer driver for the
settings. In that case, set the paper size using the printer driver.

ﬂlmportant
O Custom size settings set using the printer driver have priority over those set
using the machine's control panel.

O When the printer driver is not used, make settings using the control panel.

I] Press the [ User Tools/Counter] key.

OO =B
01616 ®

QOO
OO ﬂ

ﬂ Select [System Settings] using [ V] or [ 4 ], and then press the [ OK] key.

EUzer Tool= 1/4 & [0K]
Counter

ACS0038

ovstem Settings

8 Select [Tray Paper Settings] using [ V] or [4 ], and then press the [ OK] key.

Eavaten settinzs 177 ¥[0K|
General Features

Tray Paper settings

Timer Settings

ﬂ Select [Printer Bypass Paper Size] using [ V] or [4], and then press the [OK]
key.
B ray/Paper 270 0]
Paper Size:Trav 4

Printer Bwpass Paper Size

Paper Tvpe:Bvpass Traw




B select [Custom Size] using the scroll keys, and then press the [OK] key.

P.5ize:Bvpass F b agk[OK]
16K [ 16K

Custom 5ize

B Enter the horizontal size of the paper using the number keys, and press

[H).
Available size: 148 - 600 mm (5.83 - 23.62 in.)

Cus.SizeBypazs
Enter meazurement.

Horiz. | 2. 10, 0 |mm

<145.0-600.0%

ﬂ Enter the vertical size of the paper using the number keys, and press [ #].
Available size: 90 - 297 mm (3.55 - 11.69 in.)

Cus. 3izeByvpass
Enter meazurement.

Vert., | 29 F 0 [mm

<40, 0-237.0%

8 Press the [ User Tools/Counter ] key to return to the default screen.

@ Note

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray
Priority] in [System] of [Printer Features] (see “Printer Features”, General Set-
tings Guide). Set paper size using the control panel.

/O Reference
For printer driver settings, see the printer driver Help.

13
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Setting Thick Paper or OHP Transparencies Using the Control
Panel

The following procedures are not required if you select the printer driver for the
settings. In that case, set the paper size using the printer driver.

ﬂlmportant
O Paper size settings set using the printer driver have priority over those set us-
ing the machine's control panel.

O When the printer driver is not used, make settings using the control panel.

I] Press the [ User Tools/Counter] key.

OO =&
01016 ®

OOO
OO ﬂ

ﬂ Select [System Settings] using [ V] or [ 4 ], and then press the [ OK] key.

EUzer Tool= 1/4 & [0K]
Counter

ACS0038

ovstem Settings

8 Select [Tray Paper Settings] using [ V] or [4 ], and then press the [ OK] key.

Eavaten settinzs 177 ¥[0K|
General Features

Tray Paper settings

Timer Settings

ﬂ Select [Paper Type: Bypass Tray] using [ Y] or [A ], and then press the [OK]
key.
[BlTray/Faper 240 ¥ 0K

Paper Size:Tray 4
Printer Bwpass Paper Size

Paper Tvpe:iBvpazs Traw




B Select paper type from the menu using [ V] or [4 ], and then press the [ OK]
key.

F.Tvpe:Bypass 354 w[0K]

Thick Paper

OHP {Tranzparency)

Preprinted Paper

E Press the [ User Tools/Counter ] key to return to the default screen.

& Note

O The settings made will remain valid until they are reset again. After print-
ing on thick paper or OHP Transparencies, be sure to clear settings for the
next user.

A Reference
For the printer driver settings, see the printer driver Help.

For details about printing onto envelopes, see p.15 “Setting envelope Us-
ing the Control Panel”.

Setting envelope Using the Control Panel

I] Press the [User Tools/Counter] key.

B Select [System Settings] using the [4] or [ V] key, and then press the [ O0K]
key.
BEllzer Tools 174 ¥[0K]
Counter

Swstem Settinzs

B Select [Tray Paper Settings] using the [ 4 ] or [ ¥ ] key, and then press the [ OK]
key.
[Eleysten Settings 172 ¥
General Features

Tray Paper Settings

Timer Settings

ﬂ Select [Paper Type:Bypass Tray] using the [ 4] or [ V] key, and then press the
[OK] key.
[ETraw’F‘aper G
Paper Size:Tray 4
Printer Bwpass Paper Size

Faper Twpe:Bwpazs Traw

15



B Select [Thick Paper] using the [ 4] or [ V] key, and then press the [ OK] key.
F.Tvpe :Bvpass 344 ¥

Thick Paper
OHP {Tranzparency)

Preprinted Paper

B Select [Printer Bypass Paper Size], and then press the [ OK] key.

B ray/Paper 270 0]
Paper Size:Tray 4

Printer Bwpass Paper Size

Paper Twvpe:Bwvpass Traw

ﬂ Select the paper envelope size from [C6env[/], [C5envl/], or [DlenvlY], and
then press the [ 0K] key.

F.SizeBypass 2/h v [0K]
BA .z [ Bz
L5 En = ChEnm2
DLEm2 =17

B press the [User Tools/Counter] key to return to the default screen.



S
1. Preparing the Machine

Confirming the Connection Method

This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using This Machine as the Windows Printing port

Network connections can be established through Ethernet and IEEE 802.11b.

Available ports are determined based on the combination of Windows operating
system version and connection method used.

SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client
-TCP/IP -TCP/IP -TCP/P -TCP/IP
-IPP -IPP -IPP -IPP
< <, Standard TCP/IP <. Standard TCP/IP <. LPR
I LPR I LPR l
Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

27220358

< Windows 95/ 98

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

< Windows Me

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

17



Preparing the Machine

< Windows 2000

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

< Windows XP

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

< Windows Server 2003

Connection Method Available Ports

Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

< Windows NT 4.0

Connection Method Available Ports
Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port
LPR port
pe Reference

See the explanation about how to install the printer driver for each type of
port. For the SmartDeviceMonitor for Client port, see p.22 “Using the Smart-
DeviceMonitor for Client Port”.

For the Standard TCP/IP port, see p.28 “Using the Standard TCP/IP Port”.
For the LPR port, see p.30 “Using the LPR Port”.



Confirming the Connection Method

Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0 NetWare NetWare
Print Server Print Server File Server
N§y
S

Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

272036S

& Note
O In an IPv6 environment, Netware servers cannot be used.

A Reference
See the explanation about how to install the printer driver for each type of
network printer.
For the Windows network printer, see p.32 “Using as a Windows Network
Printer”.

For the NetWare print server and remote printer, see p.34 “Using as a Net-
Ware Print Server / Remote Printer”.
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Local Connection

Local connections can be established via parallel, USB, and Bluetooth connec-
tions.

Windows operating system version determines the available connection meth-
ods.

e Windows 95:
Parallel connections

e Windows 98:
Parallel connections

e Windows 98 SE / Me:
USB and Parallel connections

e Windows 2000:
USB, Parallel, and Bluetooth connections

e Windows XP:
USB, Parallel, and Bluetooth connections

e Windows Server 2003:
USB, Parallel, and Bluetooth connections

e Windows NT 4.0:
Parallel connections

/O Reference

See the explanation about how to install the printer driver for each method of
connection.

For the USB connection, see p.37 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.42 “Printing with Parallel Connection”.
For the Bluetooth connection, see p.44 “Printing with Bluetooth Connection”.



Installing the Printer Driver

Installing the Printer Driver

This section explains how to install the printer driver. There are two ways to in-
stall the printer driver: using Quick Install, which installs the settings at once, or
installing the appropriate driver according to the port you want to use.

ﬂlmportant
O If your operating system is Windows NT4.0, download printer driver for

Windows NT4.0 from the supplier's Web site.

Quick Install

Windows 95 / 98 / Me / 2000 / XP and Windows Server 2003 users can easily
install this software using the supplied CD-ROM.

Using Quick Install, the PCL printer driver and/or RPCS printer driver, Desk-
TopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.

ﬁ*lmportant

O To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

O If you connect using USB, refer to p.37 “Installing the Printer Driver Using
USB” and install the printer driver.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

O click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

B After reading the agreement, click [l accept the agreement.], and then click
[Next >].

B Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].

For parallel connection, select the machine whose printer port is displayed in
[Connect To].

2]
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U crick pinstall).
The printer driver installation starts.

B click [Finish].
A message about restarting the computer appears. Restart the computer to
complete installation.

g Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

ye Reference
Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.49 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.

Installing the Printer Driver for the Selected Port

Using the SmartDeviceMonitor for Client Port

iﬁklmportant

O To install SmartDeviceMonitor for Client under Windows 2000 / XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

O Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.



Installing the Printer Driver

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client].

ﬂ Select an interface language, and then click [Next >].
The default interface language is English.

B The message to quit all other applications appears. Quit all applications,
and then click [Next >].

ﬂ The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

B) click [Fullinstall] or [Custom Install].

[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.

[Custom Install] installs selected applications.

g Follow the instructions on the display and click [Next >] to proceed next
step.

[[U After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].
Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

ﬂ Open the [Printers] window from the [Start] menu.

g In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E] Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
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Windows 2000 / Windows NT 4.0:

ﬂ Open [Printers] window from [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E] On the [Ports] tab, click [Configure Port].
The [Configuration] dialog box appears.

Windows XP, Windows Server 2003:

ﬂ Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

B Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.

& Note
O For TCP/IP, timeout setting can be configured.

O User, proxy, and timeout settings can be configured for IPP.

O If no settings on the [Recovery/Parallel Printing] tab are available, follow the
procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

® Start SmartDeviceMonitor for Client, and then right-click the SmartDe-
viceMonitor for Client icon on the tasktray.

® Point to [Properties], and then click [Extended Features Settings].
@ Select the [Set Recovery/Parallel Printing for each port] check box.
® Click [OK] to close the [Extended Features Settings] dialog box.

/O Reference

For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.
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Installing the PCL or RPCS Printer Driver (TCP/IP)

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCURPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [| accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U Click [Next >].

B Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

[m Click [Port], and then click [Add].
m Click [SmartDeviceMonitor], and then click [OK].

(B Click [TCPAP], and then click [Search].
A list of printers using TCP/IP appears.

[B Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address - TCP/IP], and then enter the IP
address or host name of the machine.

ﬂ] Check that the port of the selected printer is displayed in [Port].
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iE Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

[E Select the [Default Printer] check box to configure the printer as default.

@ click [Continue].
Installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check statistics about the number of sheets which each user
prints. For details, see SmartDeviceMonitor for Admin Help.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Under Windows 95 / 98 / Me, you cannot add an IP address partially sim-
ilar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Installing the PCL or RPCS Printer Driver (IPP)

ﬂlmportant

O To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

Fd 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].
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B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [| accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

g Click [Port], and then click [Add].

[E] Click [SmartDeviceMonitor], and then click [OK].

B click pipp).

m In the [Printer URL] box, enter “http://printer's address/printer” as the print-

er's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https:/ /printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter “http://printer's address/ipp” as the printer's address.

[B Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

[ Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B click [ok).
m Check that the port of the selected printer is displayed in [Port].

[ﬂ Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

[B Select the [Default Printer] check box to configure the printer as default.
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) click [Continue].
Installation starts.

m After the installation is completed, select one of the options to restart the
m computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check the number of sheets each user prints. For details, see
SmartDeviceMonitor for Admin Help.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Using the Standard TCP/IP Port

This describes how to install the PCL or RPCS printer driver using the TCP/IP
port.

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, and
Windows Server 2003, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

O In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor for Client port.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

O Click [PCLRPCS Printer Drivers].
28
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B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [| accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U Click [Next >].

8 Select the machine model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

[ﬁ] Click [Port], and then click [Add].

ﬂ] Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

[B Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

[ Click [Next >].

iE Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

[E Check that the port of the selected printer is displayed in [Port].
[ﬂ Configure the default printer as necessary.

[B Click [Continue].
The printer driver installation starts.

[D After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.
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& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

/O Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Using the LPR Port

This describes how to install the PCL or RPCS printer driver using the LPR port.

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

Fd 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

B Click [Next >].



Installing the Printer Driver

g Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

m Click [Port], and then click [Add].

[ Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

m Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[B Enter “lp” in the [Name of printer or print queue on that server] box, and then click
[OK].

The port is added.
ﬂ] Check that the port of the selected printer is displayed in [Port].
iE Configure the default printer as necessary.

0@ click [Continue].
The printer driver installation starts.

[ﬂ After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

4 Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a Windows Network Printer

This describes how to install the PCL or RPCS printer driver when using the
printer as a Windows network printer.

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000 / XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communicate
with a Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0 print
server. Do not begin the following procedure before the client is set up and con-
figured correctly.

iﬁklmportant

O To install the printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

O If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client.

O If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

E] Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.



Using as a Windows Network Printer

U crici [Next >].

8 Select the [Printer Name] check box to select the printer models you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-

erating system, printer model, and port.
[ Click [Port], and then click [Add].
[ Click [Network Printer], and then click [OK].

[E] Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

[B Select the printer you want to use, and then click [OK].
ﬂ] Check that the port of the selected printer is displayed in [Port].

iE Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

[E Select the [Default Printer] check box to configure the printer as default.

[ﬂ Click [Continue].
The printer driver installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a NetWare Print Server / Remote
Printer

This describes how to set up the Windows computer used as the NetWare client.

iﬁklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O In an IPv6 environment, Netware servers cannot be used.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:

¢ Operating system: Windows 98

¢ NetWare version: 4.1

¢ File server name: CAREE

¢ Queue name: R-QUEUE

) insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

ﬂ Select an interface language, and then click [OK].
The default interface language is English.

B Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

[ crici Next >1.

ﬂ Select the [Printer Name] check box to select the printer model you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.



Using as a NetWare Print Server / Remote Printer

8 Double-click the printer name to display the printer settings.
The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

g Click [Port], and then click [Add].

[ Click [Network Printer], and then click [OK].

ﬂ] Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.
[E] Select the print queue, and then click [OK].
[B Check that the port of the selected printer is displayed in [Port].

0 click [Continue].
The printer driver installation starts.

B click [Finish] in the [Select Program] dialog box.

m After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

[ﬂ After restarting the computer, launch the [Printers] window, and then open
the printer properties.

Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

[B On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correct-

ly.
[ﬂ Click [OK] to close the printer properties dialog box.

4 Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet.
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Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-

er driver on Windows. If NetWare form feed is configured, the printer may not

print properly.

Follow the procedure below to disable form feed according to the operating sys-

tem used:

e Under Windows 95 / 98 / Me, clear the [Form feed] check box on the [Printer
Settings] tab in the printer properties dialog box.

e Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating
system used:

e Under Windows 95 / 98 / Me, clear the [Enable banner] check box on the [Print-
er Settings] tab in the printer properties dialog box.

e Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows Me - USB

ﬂlmportant
O Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-
dows Me or later.

O Download USB Printing Support for Windows Me from the supplier's Web
site.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

ﬂ Download USB Printing Support from the supplier's Web site.

Use a search to find the model name, and then download USB Printing Sup-
port from the supplier's Web site.

Save it where you can locate it easily.

g Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

ﬂ Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

ﬂ Specify the location where USB Printing Support is located, and then click
[Next >].

B Check the location, and then click [Next >].
USB Printing Support is installed.

 click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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B Install the printer driver. Click [Search for the best driver for your device. [Recom-
mended]], and then click [Next >].

g Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

m Insert the CD-ROM into the CD-ROM drive.

& Note
3 When Auto Run starts, click [Exit].

O To disable Auto Run, press the [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

ﬂ] Specify the location where the source files of the printer driver are stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN9X_ME\ (Language)\DISK1

e PCL 5e
D:\DRIVERS\PCL5E\WIN9X_ME\ (Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN9X_ME\ (Language)\DISK1

* PostScript 3 (“Printer Drivers and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN9X_ME\ (Language)\DISK1
[E] Check the location, and then click [Next >].
Add Printer Wizard starts.

B click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.

O Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

O After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.
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Windows 2000 - USB

ﬂlmportant

O Installing a printer driver requires Administrator permission. Log on using
an account that has Administrator permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

ﬂ In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

8 Select the [Specify location] check box, and then click [Next >].

ﬂ Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

B Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

e PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\ADRIVERS\PCL6AWIN2K_XP\(Language) \DISK1

* PostScript 3 (“Printer Drivers and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1
B Check the printer driver location, and then click [OK].
U crick [Next >].

B click [Finish.
If the printer driver has already been installed, plug and play is enabled, and

the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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& Note

O The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

ﬁ*lmportant

O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B 1n the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

E) insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

ﬂ Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\ (Language)\DISK1
e PCL 5e
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\ DISK1
e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

* PostScript 3 (“Printer Drivers and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

B Check the printer driver location, and then click [Next >].
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(3 ciick [continue].

U click [Finish].

If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window. u

& Note

O The number after “USB” varies depending on the number of printers con-
nected.
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Printing with Parallel Connection

This describes how to install the PCL or RPCS printer driver when using the par-
allel port.

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

ﬁklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog
box.

After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U crick [Next >].

8 Select the [Printer Name] check box to select the printer model you want to
use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the op-
erating system, printer model, and port.

[m Check that [LPT1:] is shown in [Port].
ﬂ] Select the [Default Printer] check box to configure the printer as default.
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B Click [Finish].
The printer driver installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Printing with Bluetooth Connection

This describes how to print using with Bluetooth devices.

Supported Profiles

Refer the following supported profiles for Bluetooth connection.

% SPP, HCRP

A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

SPP connection does not support bidirectional communications.
HCRP connection supports bidirectional communications.

% BIP

For BIP connection, a module including PostScript 3 must be installed in
the machine.

Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

Only JPEG images that can be printed using BIP.

User codes are disabled for BIP.
You cannot print if print functions are restricted.

Some printers do not support BIP.

@ Note

O In this manual, the instruction referred to print using SPP. To print using
HCRP or BIP, see the Help supplied with the Bluetooth adapter you use.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

iﬁklmportant

O To install the printer driver under Windows 2000 / XP Professional or Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

ﬂ Start 3Com Bluetooth Connection Manager.
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ﬂ Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

E] on the [Tool] menu, click [COM port].

ﬂ Check that the message “Bluetooth Serial Client (COMXx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B click [Close].

B On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
B Click the [Ponts] tab.

mUnder [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

0 ctick [ok1.
Close the [Printers] window.

@ Note

O To always use the same printer, select the [Always use for this connection]
check box.

O System requirements vary depending on the Bluetooth standard and spec-
ifications. For details, see the manuals supplied with each product.

O For information about setting up Bluetooth under other operating systems
or using it with different utilities, see the manuals supplied with those op-
erating systems or utilities.

O If a dialog box appears while transmitting a print job, reestablish network
connection as follows:

@ Select the printer you want to use in the [Printers and Faxes] box.
@ Click [Connect].

p Reference

For details, see the manuals supplied with the Bluetooth adaptor or com-
puter equipped with Bluetooth.
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Configuring Security Mode Settings

This describes how to configure the security mode settings.
ﬂ Start 3Com Bluetooth Connection Manager.

ﬂ On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

8 Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.46 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals supplied with the utility.

O click [ok.
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.46 “Printing in the Security Mode”.

Printing in the Security Mode

This describes how to print in the security mode.

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

ﬂ The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.



Making Option Settings for the Printer

Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

/O Reference

For details about making option settings for the printer, see p.49 “If Bidirec-
tional Communication Is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.

* Bidirectional communication is supported by Windows 95 / 98 / Me / 2000
/ XP, Windows Server 2003, and Windows NT 4.0.

¢ If you use the RPCS printer driver and bidirectional communication is ena-
bled under Windows 2000, the [Change Accessories] tab is unavailable.

& Note

O The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

O The PCL printer driver supports bidirectional communications. You can up-
date the machine status manually.

To support bidirectional communication, the following conditions must be met:

% When connected with parallel cables
* The computer must support bidirectional communication.
¢ The machine must support bidirectional communication.
¢ The interface cable must support bidirectional communication.

* The machine must be connected to the computer using the standard paral-
lel cables and parallel connectors.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
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< When connected with the network
¢ The machine must support bidirectional communication.
¢ DeskTopBinder Lite must be installed, or the Standard TCP/IP port must

be used.

m e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.

If the Standard TCP/IP port is not being used, one of the following conditions

must be met in addition to the two above:

* The SmartDeviceMonitor for Client port and the TCP/IP protocol must be
used.

¢ The standard TCP/IP port must be used without changing the default port
name (for Windows 2000 / XP and Windows Server 2003).

* Microsoft TCP/IP print IP address must be specified for use (for Windows
NT 4.0).

e When using IPP protocol with the PCL printer driver, the IPP port name
must include the IP address.

<+ When connected with USB
The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

& Note
O Install SmartDeviceMonitor for Client from the supplied CD-ROM.

48



Making Option Settings for the Printer

If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communications are disabled.

ﬂlmportant

O Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] (Windows 2000) or [Printers and Faxes] (Win-
dows XP / Windows Server 2003) folder. Log on as an Administrators or
Power Users group member.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

When using Windows XP or Windows Server 2003, point to [Settings] on the
[Start] menu, and then click [Printers and Faxes]. The [Printers and Faxes] win-
dow appears.

g Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

B Select options installed from the [Options] area, and then make the neces-
sary settings.

B Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

ﬂ Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from the targets of
automatic tray selection.

8 Click [OK] to close the printer properties dialog box.
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Installing Font Manager 2000

ﬂlmportant

O Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, in-
stalling applications by Auto Run requires administrator permission. To in-
stall a printer driver by Auto Run, log on using an account that has
administrator permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

The installer starts.
B Click [Font Manager 2000].

ﬂ Follow the instructions on the screen.



Using Adobe PageMaker Version 6.0, 6.5, or 7.0

Using Adobe PageMaker Version 6.0, 6.5,
or7.0

Under Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, or Windows
NT 4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker
folder.

PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME\ (Lan-
guage) \DISK1” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95 / 98 / Me.
Use the folder at this level that is appropriate for the operating system you are
currently using.

The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.

* For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4".

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

¢ For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

& Note
O If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

O When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.

@® On the [File] menu, click [Print].
The [Print Document] dialog box appears.

® Make the necessary settings in the [Features] box.
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S
2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95 /98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Make the necessary settings, and then click [OK].

@ Note

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

/O Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

& on the [File] menu, click [Print].

The [Print] dialog box appears.
ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.
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B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

p Reference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

iﬁklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

B on the [File] menu, click [Print..].
The [Print] dialog box appears.

g Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

p Reference
For details, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.
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A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

K on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list, and then click
[Preferences].

B Make the necessary settings, and then click [OK] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

S/
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g Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

iﬁklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

E] On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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RPCS - Accessing the Printer Properties

Windows 95 /98 / Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

% Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

% Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬂlmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

4 Note

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

A Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

[I On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Making Printer Default Settings - The Printer Properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

Bon the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
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B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.
B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

/O Reference
For details, see the printer driver Help.
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S
3. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the machine for printing, without having to
open a PDF application.

ﬂlmportant
O The function can be used with genuine Adobe PDF files only.

O This function supports version 1.3, 1.4, 1.5, and 1.6 PDF files.

O PDF files created using the transparency function of PDF version 1.4 cannot
be printed.

O PDF files created using Crypt Filter and/or the 16 bit colour image function
of PDF version 1.5 cannot be printed.

O PDF version 1.6 exclusive functions are not compatible.
O Some types of High Compression PDF files may not be printed. Consult your
sales representative about the supported file types.

& Note
O Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - us-
ing Auto Document Link or by entering commands.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.
ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work under certain operating system settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

B Select an interface language, and then click [OK].
ﬂ Click [DeskTopBinder-SmartDeviceMonitor for Client] , and then click [Next >].
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B Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.

DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files di-
rectly.

[I On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

ﬂ When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function2] screen appears.

8 On the [Printing Function2] screen, click [Add...] to display [PDF Direct Print Prop-
erties].

ﬂ Select Driver for This Machine, click [OK], and then click [Next] repeatedly
until [Finish] is displayed.

Click [Finish].

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

ﬂ On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].
An icon for the Function palette is added to the task bar displayed at the bot-
tom right of the screen.

ﬂ Right-click the icon that is added to the task bar, and then click [Properties]
to display the Properties screen.

B Click the [Contents] tab, select the [PDF Direct Print] check box at the centre,
and then click [OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the pal-
ette.



Printing a PDF File Directly

PDF Direct Printing

Use the method below to print PDF files directly.

ﬂ Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

ﬂ [Output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.

Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

ﬂ In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

g When [Extended Features Wizard] appears, select [Start], and then click [Next].

8 On the [Printing Function2] screen, click [Properties] to display [PDF Direct Print
Properties].

ﬂ Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].

Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

B Move the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

[ [output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

ﬂ The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password]
field at the bottom right of the screen, and then click [OK].

The password-protected PDF file is printed.

& Note
O Before printing a password-protected PDF file, perform one of the following;:

e Enter the PDF password in the PDF Direct Printing Properties screen.

* Specify a PDF password by selecting [Change PDF Password] in the [PDF
Menu] on the control panel of this machine

O If a [PDF Group Password] for the [PDF Menu] menu is assigned to either
DeskTopBinder Lite or the control panel of this machine, a same group
password needs to be assigned to the other.
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PDF Direct Print Properties

12

13

1. Setting name:
Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...

Changes the icon displayed on the tool
bar.

3. Printer:

Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex

Prints on both sides of sheets.

5. Layout
Prints multiple pages on a single sheet.

6. Display this dialog box before
printing

Appears in PDF direct printing mode if
this check box is selected.

7. Orientation
Specifies the original's orientation.

ASC005S

8. Number of copies
Specifies the number of copies to print.

9. Collate
Sorts printed sheets.

10. Range

Specifies the print area on each page.

11. Resolution
Specifies a print resolution.

12. PDF Password

If the PDF file is password-protected, en-
ter the password in this field. Otherwise,
the file cannot be printed.

13. Group Password

If a group password is assigned to Desk-
TopBinder Lite and this machine, enter
the group password in this field. Other-
wise, printing cannot start.

Using commands

You can print PDF files directly, using commands such as “ftp”,

IllprII.
/O Reference

/A

sftp”, and

For details about UNIX commands, see Network Guide.



Unauthorized Copy Control

Unauthorized Copy Control

To prevent unauthorized copying, you can embed patterns and text beneath the
print. You do not need a special paper to use this function. If a paper with text
or image patterns is copied by a copier or a multi-function printer, either the pat-
terns are printed vividly or the copy is grayed out, so as to protect the informa-
tion on the original from leaking. To print with protection against unauthorized
copying, you can use [Data security for copying] and [Mask type:].

ﬂlmportant
O This function is designed to discourage copying of confidential documents; it
does not prevent unauthorized use of information.

O You must install the Copy Data Security Unit to gray out files protected by
Data Security for Copying that are stored in the document server or printed.
You do not have to install the unit to print files that are protected by Data Se-
curity for Copying.

O You can use this machine to print files that are protected by data security for
copying. However, because you cannot install the Copy Data Security unit on
this machine, copies of files cannot be grayed out when using data security
for copying.

O Data security for copying cannot be used together Toner saving.

O Use the following setting to make the embedded pattern or text for prevent-
ing unauthorized copying more visible:

e Under [Copier Features], [Original Type Setting], set [Original Type 1 (Text)] to
[Special Mode 1].

* Note that if you make this setting, gray-scale images in documents that do
not contain embedded patterns or text might not be copied properly.

O To use the Unauthorized Copy Control function, configure the RPCS printer
driver settings as shown below. This function cannot be selected if other set-
tings are applied.

e In the [Paper Type:] list, select [Plain/Recycled].

Opening the Unauthorized Copy Control Window

ﬂ In the RPCS printer driver, open the [Printing Preference] window.
B click [Add/iChange Custom Settings...].
B Select the [Unauthorized copy...] check box.

ﬂ Click [Control Settings...].
The Unauthorized Copy Control window appears.

¢ Note
O For details, see the printer driver Help.
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Using [Data security for copying]

If a document printed with data security for copying is copied by or stored in the
Document Box of a copier or multi-function printer with the copy data security
unit, the copy or stored file is grayed out. This section explains how to specify
the printer driver setting for printing using [Data security for copying].

% Setting [Data security for copying] in the printer driver

¢ Select the [Data security for copying] checkbox. You can also enter the text in
the [Text:] box.

* You cannot select the [Mask type:] checkbox at the same time.

¢ To print a document protected by gray overprint, the machine must be set
up correctly. Consult an administrator.



Unauthorized Copy Control

% Printing a document using [Data security for copying]

1 2 3

)

AJLO30S

1. The pattern and text you have set 3. The document is blanked by gray
is printed. overprint.

2. The document is copied or stored
in copiers / multifunction machines
which the Copy Data Security unit is
installed.

& Note
O This machine can print only as described in Step 1.

O Only the RPCS printer driver is supported.

O You cannot partially embed a pattern and text in a document.
[ Use 182 x 257 mm (7!/4 x 10/, in.) or larger paper.

O Use ordinary or recycled paper of at least 70% whiteness.

O Duplex printing may interfere with this function as a result of text and pat-
terns being visible through the paper.

O Printing with background patterns and text may be slower than normal print-
ing.

A Reference
For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver
to prevent unauthorized copying.

[Corfidertal I Repeat
B v copies | Size [points]
= = agress at

[Aral -] 4 e
Fort styie Angle

e [Regular R T | 4 | T outine
Positorr Coriageretun spze2 oSl | [ Texony
e — i 4

[ = | Help | Restore Defauls

% Setting [Mask type:] in the printer driver
* Select a pattern from [Mask type:], and then enter text in the [Text:] box.

& Note
O You can set only [Text:], but [Mask type:] and [Text:] must be set together.

O To switch text and background patterns, select the [Reverse patterns:
text/background] check box.

% Printing a document using [Mask type:]

1 2 3

09
NY
o

WO
oSt

A~V A

AJLO31S

1. The pattern and text you have set 3. The pattern and text you have set
is printed palely. appear clearly.

2. The document is copied, scanned,
or stored in copiers / multifunction
machines.
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& Note

a
)
a

0

0

Only the RPCS printer driver is supported.
You cannot partially embed patterns and text strings in a document.

To make the embedded pattern clear, set the character size at least 50 pt (pref-
erably 70 to 80 pt) and character angle to between 30 and 40 degrees.

Due to the effects of the settings, the results of copying, scanning, and saving
documents in the document server may vary depending on the machine
model and setting conditions.

Printing with background patterns and text may be slower than normal print-
ing.

/O Reference

For details about setting [Mask type:], see the printer driver Help.

Important Notice

The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print pat-
terns and the performance of Unauthorized Copy Control may vary depend-
ing on the quality of paper used and the machine model and settings.

The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print pat-
terns.
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Form Feed

This section gives instructions for operating the machine when there is no tray
for the selected paper size or type, or when paper loaded in the machine has run
out.

ﬂlmportant
O The tray cannot be changed if the following functions are set:

* Duplex Print to a tray that does not support duplex printing

& Note

O If form feed is selected for a tray with the following settings, you can change
the tray by canceling the settings:

¢ Duplex Print

O If Auto Continue is selected, form fed paper is printed after a set interval. See
“Printer Features”, General Settings Guide.

Printing from a Selected Tray

If the machine does not have a tray for the selected paper size or paper type, or
if the selected paper loaded in the machine has run out, a caution message ap-
pears. If this message appears, do the following procedure.

ﬂ When the caution message appears, press [FormFeed].

Change Tray 1 to the
following settings:
B3P laindRecyeled

[JobRezet |FormFeed

ﬂ On the confirmation screen, press [ OK].

FormFeed the fol lowing:
7

[Ifh:ucument Lt
[ Cancel | O

If you want to stop printing, press [Cancel].




Form Feed

B Select the tray for form feed using [ V] or [ 4 ] from those that appear on the
display panel, and then press the [ 0K] key.

If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

select Traw 142 ¥[0K]
i = Y
L

The machine prints using the selected tray.

& Note
O If a tray with a smaller paper size is selected, the print job may be cut short,
or other problems may occur.

Canceling a Print Job

Follow this procedure for canceling the print job if the message prompting form
feed appears.

ﬂ Press [JobReset].

Chanze Tray 1 to the
following =settinzs:
B3P lain/Recyeled

[JobReszet |FormFeed

ﬂ Press [Current].

Reset the following job:

[ Current | Resume

The confirmation message appears.
To resume printing jobs, press [Resume].

8 Press [Yes] to cancel the print job.

Reset the current job?

[ HNo | ‘es

Press [No] to return to the previous display.
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& Note

O If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

O Under Windows, If the machine is connected to the computer using a par-
allel cable, sent print jobs may be canceled if [JobReset] is pressed while
“Waiting...” is displayed on the control panel. After the interval set in [I/O
Timeout] in Printer Features has passed, the next print job can be sent. A
print job sent from a different client computer will not be canceled in this
case.

O You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

O A print job containing a large volume of data may take considerable time
to stop.

A Reference
For details, see p.81 “Canceling a Print Job”.



Canceling a Print Job

Canceling a Print Job

This section gives instruction to stop printing from the computer or the control
panel.

Canceling a Print Job Using the Control Panel

ﬂ Press [JobReset] on the display panel.
A confirmation message appears.

ﬂ Press [Current].

Reset the fallowing job:

[ Current | Resume

To resume printing jobs, press [Resume].

B Press [Yes] to cancel the print job.

Reset the current job?

[ Mo | ‘es

Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not com-
pleted.

ﬂ Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

g Select the name of the job you want to cancel.

B On the [Document] menu, click [Cancel Printing].

O press the [ Printer] key on the machine's control panel.

& Note

0

0

If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

If the machine is connected to the computer using a parallel cable, sent
print jobs may be canceled if [JobReset] is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

In Windows XP, Windows Server 2003, and Windows NT 4.0, click [Cancel]
on the [Document] menu.

In Windows 95 / 98 / Me / 2000 or Windows NT 4.0, you can also open
the print job queue window by double-clicking the machine icon in the
[Printers] machine window (the [Printers and Faxes] window under Win-
dows XP and Windows Server 2003).

You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

A print job containing a large volume of data may take considerable time
to stop.



Checking the Error Log

Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

ﬁklmportant
O The most recent 30 errors are stored in the error log. If a new error is added
when there are 30 errors already stored, the oldest error is deleted.

O If the main power switch is turned off, the log is deleted.
0 press the [Printer] key to display the Printer screen.
ﬂ Press [Menu].

JobReset | |  Henu

B press [Show Error Log] and then press the [ OK] key.

ﬂ Select the error log you want to check using [V] or[4].
Error Log HiG ¥
TR

dkkdkt Feb, 20 01:21FPM
Miuthent ication Error

A detailed error log appears.

& Note

O Press the [Escape] key until the Printer screen appears after checking the
log.

O To print files that appear in the error log, resend them after stored files
have been printed or deleted.
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Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data
transmitted from a computer in memory. The following are the two types of col-
late:

ﬁlmportant
O Rotating Collate is not possible when feeding paper from the bypass tray.

O If jobs containing pages of various sizes are set, Rotating Collate will not
work.

% Collate
Printed output is assembled as sets in sequential order.

>
123 123 123 123

< Rotating Collate
Every other print set is rotated by 90 degrees [J.

T

AEU016S

AEU017S

& Note
O You can set Collate in the RPCS printer driver.

If Auto Continue occurs on the first set, Collate will be canceled.
If forced printing occurs on the first set, Collate will be canceled.

aaa

If a document with mixed paper sizes or sizes larger than A4, 8!/, x 11 is set,
it can only be collated, even if Rotating Collate has been selected.

Q

When Rotating Collate has been selected, printing speed will be slower than
with other collate functions.

O When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

O The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.



Collate

p Reference

For information about paper sizes and the number of sets you can use Collate
or Rotating Collate with in every option, see Copy Reference.

For printing methods, see the printer driver Help.
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Other Print Operations




S
4. The Functions and Settings

of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.

p Reference

For details about functions and setting items, see Network Guide, PostScript
3 Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:
* Copy

* Printer

¢ Scanner

¢ Fax

4 Note

O The machine must be equipped with the Printer /Scanner Unit in order to use
the printer or scanner function.

Interface

The following interfaces are available with the machine:
e Ethernet (100BASE-TX / 10BASE-T)

e USB (2.0)

» IEEE 1284 (Parallel) (Optional)

» JEEE 802.11b (Wireless LAN) (Optional)

* Bluetooth (Optional)

& Note
3 To use the IEEE 1284, IEEE 802.11b (wireless LAN), or Bluetooth interface, the
machine must be equipped with the corresponding unit for that interface.

3 You cannot have the IEEE 1284, IEEE 802.11b (wireless LAN), and Bluetooth
interface on the machine at the same time.
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The Functions and Settings of the Machine

List of the Setting ltems

Web Image Monitor

The following tables show Web Image Monitor items that can be viewed or mod-
ified depending on the selected mode on the Web browser.

Select one of the following modes to log on Web Image Monitor:
¢ User mode: log on as a user
¢ Administrator mode: log on as an administrator

< Home
m e Status
Menu User mode Administrator mode
Toner Read Read
Input Tray Read Read
Output Tray Read Read
e Device Info
Menu User mode Administrator mode
Functions Read Read
System Read Read
Version Read Read
Printer Language Read Read
e Counter
Menu User mode Administrator mode
Copier Read Read
Printer Read Read
Fax Read Read
Send/TX Total Read Read
Fax Transmission Read Read
Scanner Send Read Read
Other Function(s) Read Read
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List of the Setting Items

% Job
e Job List
Menu User mode Administrator mode
Current/Waiting Jobs Read Read / Modify
Job History Read Read
e Printer
Menu User mode Administrator mode
Job History Read Read
Error Log Read Read

¢ Fax History

Menu User mode Administrator mode
Transmission Read Read
Reception Read Read
LAN-Fax Read Read

« Address Book

Menu User mode Administrator mode

Address Book None Read /Modify

% Configuration

* Device Settings

Menu User mode Administrator mode

System Read Read/Modify
Paper Read Read /Modify
Date/Time Read Read/Modify
Timer Read Read/Modify
Logs None Read/Modify
E-mail Read Read /Modify
Auto E-mail Notification None Read /Modify
On-demand E-mail Notification | None Read /Modify
File Transfer None Read /Modify
User Authentication Man- | None Read /Modify
agement

Administrator Authentica- | None Read/Modify
tion Management
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The Functions and Settings of the Machine

Menu User mode Administrator mode
Program/Change Administrator | None Read /Modify
LDAP Server None Read/Modify
Firmware Update None Read /Modify
Printer
Menu User mode Administrator mode
Basic Settings Read Read /Modify
Tray Parameters (PCL) None Read /Modify
Tray Parameters (PS) None Read /Modify
PDF Temporary Password | Modify None
PDF Group Password None Modify
PDF Fixed Password None Modify
Fax
Menu User mode Administrator mode
General None Read /Modify
Administrator Tools None Read /Modify
E-mail Settings None Read /Modify
IP-Fax Settings None Read /Modify
IP-Fax Gateway Settings None Read /Modify
Parameter Settings None Read /Modify
Interface
Menu User mode Administrator mode
Interface Settings Read Read/Modify
Network
Menu User mode Administrator mode
IPv4 Read Read/Modify
IPv6 Read Read/Modify
NetWare Read Read /Modify
AppleTalk Read Read /Modify
SMB Read Read/Modify
SNMP None Read /Modify
SNMPv3 None Read /Modify
SSDP None Read /Modify
Bonjour Read Read /Modify
System Log Read Read




List of the Setting Items

* Security
Menu User mode Administrator mode
Network Security None Read /Modify
Access Control None Read /Modify
IPP Authentication None Read /Modify
SSL/TLS None Read /Modify
ssh None Read/Modify
Site Certificate None Read/Modify
Device Certificate None Read/Modify
* RC Gate
Menu User mode Administrator mode
Setup RC Gate None Read /Modify
Update RC Gate Firmware | None Read /Modify
RC Gate Proxy Server None Read /Modify
e Webpage
Menu User mode Administrator mode
Webpage Read /Modify Read /Modify
¢ Extended Feature Settings
Menu User mode Administrator mode
Startup Setting None Read /Modify
Extended Feature Info None Read
Install None Read /Modify
Uninstall None Read/Modify
Administrator Tools None Read/Modify
Copy Extended Features None Read/Modify
Copy Card Save Data None Read /Modify
& Note

O Some items are not displayed depending on the security settings.
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The Functions and Settings of the Machine

telnet

The following telnet can be used with the machine:

access, appletalk, authfree, autonet, bonjour (rendezvous), btconfig, device-
name, dhcp, diprint, dns, domainname, help, hostname, ifconfig, info, ipp, ipv6,
lpr, netware, passwd, prnlog, route, set, show, slp, smb, snmp, sntp, ssdp, ssh,
status, syslog, upnp, web, wiconfig, wins

Settings that can be used with PostScript 3

The following PostScript 3 settings can be used with the machine:

@ Note

O Depending on a type of printer drivers, different items may be displayed.

Settings Selectable Items
Fit to Paper Prompt User, Nearest Size and Scale, Nearest Size and Crop
Collate Off, On
Print Mode Through, Edge smoothing, Toner Saving
Dithering;: Auto, Photographic, Text, User Setting

Image Smoothing:

Off, On, Auto, Less than 90 ppi, Less than 150 ppi, Less than
200 ppi, Less than 300 ppi

Destination

Printer Default, Internal Tray, Upper Internal Tray

Orientation Override

Off, Landscape, Portrait

Watermark

Off, On

Watermark Text

CONFIDENTIAL, COPY, DRAFT, FINAL, FILE COPY,
PROOF, TOP SECRET

Watermark Font

Helvetica Bold, Courier Bold, Times Bold

Watermark Size

24 Point, 36 Point, 48 Point, 60 Point, 72 Point

Watermark Angle

180 Degrees, 135 Degrees, 90 Degrees, 45 Degrees, 0 Degrees,
-45 Degrees, -90 Degrees, -135 Degrees, -180 Degrees

Watermark Style

Gray, Outlined




Specifications

This section contains the machine's electrical and hardware specifications, in-

cluding information about its options.

Component

Specifications

Resolution

600/300 dpi

Printing speed

16 ppm/20 ppm
(A4[), 8'/2 x 11 [J plain paper)

Printing speeds depend on the machine. Check which type of ma-
chine you have. See About This Machine.

Interface

Standard:

¢ Ethernet interface (100 BASE-TX / 10 BASE-T)
e USB 2.0 interface

Option:

* IEEE 1284 parallel interface

Use a standard 36-pin printer cable not longer than 3 meters (10
feet).

e TEEE 802.11b wireless LAN interface
¢ Bluetooth interface

Network protocol

TCP/IP, IPX/SPX, AppleTalk

Printer language

Standard: RPCS, PCL 5e, PCL XL
Option: PostScript 3, PDF

Fonts

PCL XL/5e :

Monotype Imaging 35 Intellifonts, 10 TrueType fonts, 13 Interna-
tional fonts, and 1 Bitmap font.

PostScript 3 :
136 fonts (Type 2:24, Type 14:112)

Memory

384 MB

Network cable

100 BASE-TX / 10 BASE-T shielded twisted-pair (STP, Catego-
ry/Type5) cable.

USB Interface (Standard)

¢ Supported Operating System:
Windows Me / 2000 / XP, Windows Server 2003, MacOS9.2.2,
MacOS 10.3.3 or later

¢ Transmission spec.
USB 2.0 Standard

¢ Connectable Device:
Devices corresponding to USB 2.0 Standard
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Appendix

& Note
O When using MacOS, use only the standard USB interface. The optional USB
interface board is not supported.

O When using the USB Interface (Standard) with MacOS 9.2.2, only USB 1.1 is
supported.

O When using the USB Interface (Standard) with Windows Me, install USB
Printing Support. Windows Me only supports USB 1.1 speed.

Options

ﬁ*lmportant
O The IEEE 802.11b interface unit, the IEEE 1284 interface board, and Bluetooth
interface unit cannot be installed concurrently.

IEEE 1284 Interface Board Type A

% Transmission spec.:
IEEE 1284

% Required cable:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

% Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

<+ Protocol:
TCP/IP, IPX/SPX, AppleTalk

& Note
O SmartDeviceMonitor and Web Image Monitor are supported.

+ Data transfer speed:
Auto select from below speed

1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps
+ Frequency range:

e Inch version:
2412 - 2462 MHz (1 - 11 channels)

¢ Metric version:
2412 - 2472 MHz (1 - 13 channels)



Specifications

< Transmittable distance:
1 Mbps 400 m
2 Mbps 270 m
5.5 Mbps 200 m
11 Mbps 140 m

& Note
O These figures are a guideline for outdoor use. In general, the transmittable
distance indoors is 10 - 100 m, depending on environment.

% Transmission mode:
Ad hoc, and infrastructure mode

Bluetooth Interface Unit Type 3245

% Supported Profiles:
e SPP (Serial Port Profile)
¢ HCRP (Hardcopy Cable Replacement Profile)
¢ BIP (Basic Imaging Profile)

+ Frequency Range:
2.45 GHz ISM band

« Data Transmission Speed:
723 kbps

& Note

O The transmission speed is adjusted according to factors such as the dis-
tance and obstacles between the devices, radio signal condition and Blue-
tooth adaptor.

+« Maximum Range:
10 m
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“The Product complies with the requirements of the EMC Directive 89/336/EEC and its amending di-
rectives and the Low Voltage Directive 73/23/EEC and its amending directives.”

Declaration of Conformity

In accordance with IEC 60417, this machine uses the following symbols for the main power switch:
| means POWER ON.
O means POWER OFF.

Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® s a registered trademark of Hewlett-Packard Company.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and True Type are trademarks of Apple Computer,
Inc, registered in the U.S. and other countries.

Bonjour™ is a trademark of Apple Computer Inc.

IPS-PRINT™ Printer Language Emulation Copyright® 2000, Oak Technology, Inc., All Rights Re-
served.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

NetWare is a registered trademark of Novell, Inc.
UPnP is a trademark of the UPnP Implementers Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:
e The product name of Windows® 95 is Microsoft® Windows® 95
* The product name of Windows® 98 is Microsoft® Windows® 98
e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me)
» The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server
e The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional
e The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition
» The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Copyright © 2006
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